
 
 
 
 

RepeaterNetT M Craft for the  

PES800 NR 

 
 

 

 

 

 

 

 

      
550-1200-02, Revision D1 

RepeaterNet Software Version 2.7.1 
January 2005 

                

Corporate Headquarters 
39 Grand Canyon Ln, San Ramon 

California  94582  USA 
Telephone: +1 925 901-0103 
Facsimile: +1 925 901-0403 

www.peninsulaengineering.com 



Revision D1, January 2005 
 

39 Grand Canyon Ln, San Ramon 
California 94582 

United States of America 
Telephone: +1 925 901-0103 
Facsimile: +1 925 901-0403 

www.peninsulaengineering.com 
 

© 2005 Peninsula Engineering Solutions, Inc. All rights reserved. 

All figures, tables, and text in this manual are the property of Peninsula Engineering Solutions, Inc.  
This manual provides product, ordering, installation, testing, maintenance, and application information for this 
product. This information is confidential; any unauthorized duplication, distribution or electronic transfer of the 
materials to anyone other than Peninsula Engineering Solutions’ authorized employees is forbidden. 

By accepting this operations manual from Peninsula Engineering Solutions, you agree to hold, in strictest 
confidence the materials and information herein, and not to use or to disclose this information to any person, firm 
or corporation, without the express written permission of Peninsula Engineering Solutions. “Confidential 
Information” refers to any Peninsula Engineering Solutions proprietary information, technical data, know-how, 
product plans, products, services, designs, drawings, hardware configuration information, and tables featured in 
this manual. 

Peninsula Engineering Solutions, Network Repeater, and SmartPower are trademarks of Peninsula Engineering 
Solutions, Inc.  RepeaterNet is a trademark of Repeater Technologies, Inc.  Microsoft and Windows are registered 
trademarks of Microsoft Corporation.  Other brands and their products are trademarks or registered trademarks of 
their respective holders. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
Contents 

Chapter 1.  Installing RepeaterNet................................................................................................. 1 
RepeaterNet Craft Software ....................................................................................................... 1 
Minimum System Requirements................................................................................................. 1 
Installation Procedure ................................................................................................................. 2 
Configuration............................................................................................................................... 3 

Chapter 2.  RepeaterNet Craft ........................................................................................................ 4 
Configuring the Repeater Connection ........................................................................................ 4 
Starting Craft............................................................................................................................... 4 
PES800 NR Craft Main Control Screen...................................................................................... 5 
Configuration............................................................................................................................... 6 
Status Reporting ......................................................................................................................... 6 

Alarm Status Reporting on the Main Control Screen........................................................... 6 
Defining Alarm Severity .............................................................................................................. 7 

Chapter 3. Configuring PES800 NR Properties............................................................................ 8 
Channel Properties ..................................................................................................................... 8 

Channel Alarms Tab............................................................................................................. 8 
Channel # Tab...................................................................................................................... 8 

PA Properties.............................................................................................................................. 9 
PA Alarms Tab ..................................................................................................................... 9 
PA Gain Tab......................................................................................................................... 9 
PA Control Tab................................................................................................................... 10 

ACU Properties ......................................................................................................................... 10 
Inputs and Outputs ............................................................................................................. 10 
ACU I/O Descriptions Tab.................................................................................................. 11 
ACU I/O Controls Tab ........................................................................................................ 11 
ACU Alarms Setting Tab .................................................................................................... 11 
External DC Voltage Alarm Threshold ............................................................................... 12 

Modem Properties Screen ........................................................................................................ 12 
Alarms Setting .................................................................................................................... 12 
Modem Properties .............................................................................................................. 13 

Over-the-Air Repeater Modem Setup.......................................................................... 13 
Pager Setting...................................................................................................................... 14 

Cell Phone Properties............................................................................................................... 15 
Power System Properties ......................................................................................................... 16 

Chapter 4.  Monitoring PES800 NR Status.................................................................................. 18 
Channel Filter Status ................................................................................................................ 18 
PA Status .................................................................................................................................. 18 

PA Alarm ............................................................................................................................ 19 
PA Measurement................................................................................................................ 19 

ACU Status ............................................................................................................................... 19 
ACU Alarm ......................................................................................................................... 19 
ACU Measurement............................................................................................................. 19 

Modem Status........................................................................................................................... 20 
Cellular Phone Status ............................................................................................................... 20 
Power System Status ............................................................................................................... 20 

Alarm .................................................................................................................................. 20 
Voltages.............................................................................................................................. 21 

Chapter 5. RepeaterNet Commands............................................................................................ 22 
File Menu—PES800 Craft ........................................................................................................ 22 

Download Properties .......................................................................................................... 22 
Upload Properties............................................................................................................... 23 

Craft for the PES800 NR  Contents – Page iii 



 
Update Repeater Firmware................................................................................................ 23 
Exit...................................................................................................................................... 24 

Configuration Menu—PES800C NR Craft................................................................................ 25 
System Menu—PES800C NR Craft ......................................................................................... 25 

Properties ........................................................................................................................... 25 
System Tab.................................................................................................................. 25 
System Inventory Tab.................................................................................................. 26 
System Login Tab........................................................................................................ 26 

Alarm and Event Log.......................................................................................................... 27 
Saving, Printing, and Editing the Log .......................................................................... 27 

Options Menu—PES800C NR Craft ......................................................................................... 27 
Color Independent Icons .................................................................................................... 27 
Alarm Sounds..................................................................................................................... 27 
Hold Connection................................................................................................................. 27 

Help Menu—PES800C NR Craft .............................................................................................. 28 
Navigating Help .................................................................................................................. 28 
Exiting RepeaterNet ........................................................................................................... 28 

Appendix A.  Default Alarm Settings........................................................................................... 31 
Appendix B.  RepeaterNet Executables...................................................................................... 33 
Appendix C.  The OKI Cellular Phone ......................................................................................... 35 

Accessing the OKI Cellular Phone ........................................................................................... 35 
Programming the OKI Cellular Phone ...................................................................................... 35 

Programming Mode Access ............................................................................................... 35 
Speed Dial Memory Clear .................................................................................................. 36 
Default Data Set ................................................................................................................. 36 
Lock/Unlock Code Programming ....................................................................................... 36 
Telephone Number Programming...................................................................................... 36 
Authentication Key Programming....................................................................................... 36 
Home SID Programming .................................................................................................... 36 
ACCOLC Number............................................................................................................... 36 
GID Number ....................................................................................................................... 36 
Emergency Number ........................................................................................................... 36 
Preferred SID Programming............................................................................................... 37 
Language Option Set ......................................................................................................... 37 
System Options Programming ........................................................................................... 37 

Appendix D.  Troubleshooting..................................................................................................... 39 

Craft for the PES800NR  Contents – Page  iv    



 
Chapter 1.  Installing RepeaterNet    

This chapter briefly describes the components of the RepeaterNet software, identifies minimum 
system requirements, and describes the installation procedure. 

RepeaterNet Craft Software 
The RepeaterNet Craft software (Craft) provides Windows-based configuration management and 
alarm monitoring for individual Peninsula Engineering Solutions repeaters and dynamically 
manages sessions in real time through one of these connections: 

⇒ A laptop computer with a direct connection to the repeaters—a technician can visit 
repeater sites and connect to the repeaters directly using the serial port on the laptop. 

⇒ A laptop or desktop computer with a modem connection to the repeater—with the modem 
connection, a technician need not visit the physical repeater sites to connect to the 
repeaters. 

The Craft user interface varies, depending upon the model repeater being configured or 
monitored.  

Minimum System Requirements 
Craft system requirements include: 

� Pentium 120 MHz running Windows 95 with 32 MB of memory 

� Approximately 10 MB of free disk space 

� Modem (if a modem connection is to be used).   
 
Use “Hayes-compatible” modems only.  “Connect with Rockwell” certified for 56K modems.  
US Robotics modems are not supported. 

NOTES: 

� You must have Administrator privilege to install Craft 2.7.1 software when running Windows 
NT, Windows 2000 or Windows XP 

� The Craft system must be used with Windows 95 with Service Pack 1 Update (Version 
4.00.950 A) or later releases, or with Windows NT, Service Pack 3 Update. 

� If you use a fax program such as Microsoft Fax, make sure that the Auto Answer feature is 
disabled.  See Appendix D. Troubleshooting on page 38, Problem 7 for information about 
disabling the Auto Answer feature for Microsoft Fax. 
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Installation Procedure 
The PES800 NR Craft 2.7.1 software is distributed on 11 HD floppy diskettes or in single file 
format on CD or other media.   

The software is also available on www.peninsulaengineering.com website. Go to the cellular / 
PCS repeaters section and follow the links to the Craft Software – 2.7.1, FTP download. 

To install from diskettes: 

1. Insert Disk 1 in your computer’s a: drive. 

2. From the Windows Start menu, select Run. 

3. Type a:\setup and click on OK. 

4. Follow the online instructions to install the Craft software. 

 

To install from CD in single file format: 

1. Insert CD in the computer’s d: drive 

2. From the Windows Start menu, select Run. 

3. Type: d:\craft_271.exe and click OK. 

4. Follow the online instructions to install the Craft software. 

 

Any other single file format is installed by finding the file craft_271.exe and opening the file or 
double clicking on the file name. Follow the online instructions to install the Craft software. 

The Craft software comes with default configuration files, which you can download to your 
repeater to avoid having to configure the properties manually.  See Download Properties on 
page 22. 
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Configuration 
The following table contains a list of tasks that are part of the PES800 NR Installation Checklist.  
This table guides you to the appropriate section of this manual. 

Task Section Page 

Connect the repeater through a COM port Configuring the Repeater 
Connection 

4 

Check Power System alarms Power System Status 20 

Confirm Forward and Reverse PAs are OFF PA Properties 
     PA Control Tab 

 
10 

Select an operating channel or band Channel Properties 
     Channel # Tab 

8 

Set repeater gain PA Properties 
     Gain Tab 

9 

Activate Forward and Reverse PAs (ON) PA Properties 
     PA Control Tab 

10 

Monitor Forward RF output power and adjust 
position of donor antenna to maximize Relative 
Power Out 

PA Status 
     Measurements Tab 

19 

Configure Alarm Severity Configuring PES800 NR 
Properties 

8 

Configure System Properties System Menu—PES800 NR Craft 
     System Tab 

8 
  

Configure Subsystem Properties Configuring PES800 NR 
Properties 
     Channel 
     PA 
     ACU 
     Modem 
     Cell phone 
     Power System 

 
8 
9 

10 
12 
14 
16 

Backup your configuration File Menu—PES800 NR 
     Download Properties 
     Upload Properties 

 
22  
29 
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Chapter 2.  RepeaterNet Craft 

Configuring the Repeater Connection 
You must use the Admin program to configure the connection to the repeater before you can 
access the RepeaterNet Craft software.  Follow this path from the Start menu to invoke the  
RepeaterNet Administrator:   

 Start -> Programs -> RepeaterNet Craft 2.7.1 ->  RepeaterNet Admin  

When you invoke the Administrator, a window such as the following is displayed: 

You can save both Direct and Dial-Out (Modem) 
configurations, but remember to assign a unique COM 
Port Number to each.   

 

Also, be sure to check Use this connection for only 
one of the configurations.  The connection checked is 
the connection RepeaterNet Craft uses to connect to 
the repeater. 

For example, you may assign the connection type as 
Direct through COM Port 1.  You can check the Use 
this connection box to make this your default 
configuration.  Click on Save. 

Next, you can save a Modem configuration to another 
COM port, such as COM Port 2: 

1. Assign a COM Port Number that is different  
from the COM Port Number used for Direct connection. 

2. Click on Save, then click on OK to exit RepeaterNet Admin. 

Starting Craft 
Double-click the Craft icon to display this window. 

RepeaterNet connects to the repeater and displays the 
Craft Main Control screen for the PES800 NR. 

Craft for the PES800 NR  Chapter 2.  RepeaterNet Craft  – Page 4  



 

PES800 NR Craft Main Control Screen 
The Craft Main Control screen provides access to all monitoring and control functions of the 
PES800 NR through subsystem icons and Craft menu commands.  Main Control screen icons 
(labeled on the following screen) provide access to subsystem status screens and report alarms. 

 
 

Craft Configuration menu commands let you access subsystem Properties screens, on which 
you can change subsystem configuration settings. 

NOTES:   
� All units are shipped with PAs turned OFF as indicated by the PA OFF indicator (a circle with 

a slash through it) displaying over each PA subsystem icon (FPA and RPA). PAs should 
remain OFF until gain is adjusted. 

� The Main Control screen displays differently depending on the hardware configuration of the 
unit.  For example, Channel 2 icons are grayed-out (unavailable) for a single-channel 
repeater. 

Channel 1
Forward Channel

Select Filter

Reverse Power 
Amplifier

Channel 2 Forward 
Channel Select Filter

Modem

Alarm Control 
Unit

Forward Power 
Amplifier 

Cellular 
Phone 

Power 
System 
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Configuration 

Configure the PES800 NR on subsystem Properties screens, which you can display from the 
Craft Configuration menu.   
The Configuration menu contains the following: 

Channel 1...................... Available on all units 
Channel 2...................... Available on 2-channel units only 
Forward PA .................. Power amplifier; available on all units 
Reverse PA .................. Power amplifier; available on all units 
Alarm Control Unit ........ ACU 
Modem.......................... Internal or external modem option 
Cellular phone............... Cellular option only 
Power System............... Input, battery, and internal 

Status Reporting 
Once you have configured the repeater, you can monitor and control PES800 NR system 
functions on subsystem Status screens.  Click a subsystem icon to open its status screen.  
Subsystem icons are shown on the PES800 NR Main Control screen shown on the previous 
page. 

When an alarm is triggered, the subsystem icon changes appearance, blinks, and activates an 
audible alarm (if you check Alarm Sounds On in the Options menu).  Clicking on the icon and 
viewing the subsystem status screen stops the blinking and the audible alarm.  The display of the 
icon does not revert to normal until the alarm condition is cleared. 

The color of the Forward PA and Reverse PA icons also indicate the operational status of the 
PAs.  If a PA is OFF, a circle with a slash is displayed over the associated icon. 

When RepeaterNet displays a subsystem as disabled, the subsystem is unavailable to the 
repeater.  For example, in repeaters without a cellular phone, the cellular icon is displayed in light 
gray. 

Alarm Status Reporting on the Main Control Screen 
RepeaterNet uses a color system to report subsystem alarm status on the Main Control screen.  
The meanings of the colors, and color independent icons, is shown in the following table. 

 
Subsystem Alarm Status  

 
Icon Color 

Color-Independent  
            Icon 

 
Action 

Normal—No Alarm Green N/A N/A 
Critical Alarm Red X through icon Call Out 

Major Alarm Yellow Back slash through 
icon 

Call Out 

Minor Alarm Blue Dashed back slash 
through icon 

Call Out 

Event White None None 
Disabled Dark Gray* N/A None 
System Not Available Light Gray N/A` N/A 
* When all alarms in individual subsystems are disabled, the icon color displays in dark gray. 

When an alarm is triggered, the icon color of the affected subsystem changes from green (normal) 
to the color of the alarm definition, and the icon blinks. 
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RepeaterNet also offers two optional alarm features: 

� The Color Independent Icons feature is provided for operators unable to distinguish colors.  

� The Alarm Sounds feature adds an audible alarm. 

Should more than one alarm within an individual subsystem be triggered, the higher severity alarm 
is reported on the Main Control screen.  

For example, if both a major and a minor Reverse PA alarm triggers, a yellow subsystem icon is 
reported.  If the major alarm is cleared while the minor alarm remains active, a blue subsystem 
icon is reported. Color-independent icons also report the higher severity alarm, should more than 
one alarm on an individual subsystem be triggered. 

NOTE:   When a subsystem alarm is triggered, click the icon (to open the status screen) to 
terminate the icon blinking feature and silence the audible alarm.  Icon color continues to 
report and a color independent icon (if applicable) continues to display until the alarm is 
cleared.  Color reporting does not apply to subsystems set to Event severity. 

Defining Alarm Severity 
The PES800 NR is factory-configured with a standard set of alarm severity settings.  Adjust alarm 
severity on the subsystem Properties screens.  See Configuring PES800 NR Properties on 
page 8 for more information about alarm severity and the factory configuration. 

The levels of alarm severity are: 

� Critical 
� Major 
� Minor 
� Event 
� Disabled 

To define alarm severity: 

1. Login to a session with the repeater. 

2. Select Configuration from the Main Control menu bar, then select a subsystem to open its 
Properties screen. For example, select Configuration -> Channel 1. 

The Alarms tab is displayed, showing alarm fields.  

3. Click the down-arrow next to an alarm field to select a new alarm severity. 

4. Click Apply or OK. 
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Chapter 3. Configuring PES800 NR Properties 

Use the subsystem Properties screens to perform configuration of the repeater.  To open a 
Properties screen, select a subsystem from the Configuration menu:  

� Channel 1 
� Channel 2 
� Forward PA 
� Reverse PA 
� Alarm Control Unit 
� Modem  
� Cellular Phone 
� Power System 

The Properties screens display tabs specific to each subsystem.  Some subsystem Properties 
screens include tabs for redefining alarm severity and specifying operational settings; others have 
a single tab for redefining alarm severity. 

Configuration includes: 

� Redefining alarm severity 
� Specifying operational settings for the repeater 

Channel Properties  

 

From the Main Control screen menu bar, select 
Channel 1 or Channel 2 (for 2-channel units 
only) from the Configuration menu to open a 
Channel Properties screen.  This screen allows 
access to initial configuration settings for the 
Channel 1 and Channel 2 subsystems. 

Channel Alarms Tab 
Redefine alarm severity for the Fwd Filter, and 
Rev Filter subsystems on these tabs.  

Channel # Tab 
The Channel # tab lets you set the operating 
channel or band for Channel 1 or Channel 2.  
Once you select a channel, the corresponding 
frequencies are displayed.  Consult your network 
administrator or the system site plan for the 
proper channel or band setting.  

 

NOTE:  The S and SE versions of the PES800 NR do 
not required any channel setup.  The channel 
displayed in the Properties screen reflects the 
factory configuration and is displayed for 
informational purposes. 
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PA Properties 
Select Forward PA or Reverse PA from the Main Control Screen Configuration menu to display 
the PA Properties screen. 

PA Alarms Tab 
Use this tab to define alarm severity for the FPA and RPA subsystems.  Values can be Disabled, 
Event, Minor, Major, and Critical. 

 

Subsystem alarms are:  

PA Alarm 
Indicates a component failure in the 
Power Amplifier assembly. The channel 
is inoperative. 

Thermal Shutdown Alarm 
Indicates the system temperature has 
exceeded the alarm threshold.  The 
repeater has been shut down.  When the 
temperature falls below subsystem 
tolerances, the repeater automatically 
reactivates the PA. 

External Shutdown Alarm 
Indicates that the repeater has been shut 
down by a user. 

 

Rev PA FEA Alarm 
(Reverse PA only.)  Indicates the repeater 
shut down the PA because the ALC power 
limit was exceeded. 

PA Gain Tab 
RepeaterNet detects the power amplifier 
configuration of the repeater and displays the 
applicable gain range on the Gain tab. You 
must balance gain carefully in any application 
to ensure proper hand-off and system 
operation.   

 

Consult the Site Plan or network engineering 
documentation when adjusting gain.  If no such 
documentation is available, contact your 
network administrator.   

You can adjust Forward PA and Reverse PA 
gain. There is one gain setting for forward and 
one gain setting for reverse on both one- and 
two-channel units.  The adjustable gain range 
of the power amplifiers depends upon the type 
of repeater you are using and the power level 
of the power amplifiers.
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RepeaterNet limits gain adjustment to valid 
selections only. 

NOTE: RepeaterNet detects the power amplifier 
configuration of the repeater and displays the 
applicable gain range on the Gain tab. 

 

To adjust Forward PA or Reverse PA gain: 

1. Select Forward PA or Reverse PA from the 
Craft Configuration menu to display the PA 
Properties screen. 

2. Click the Gain tab. 

1. Click-drag the horizontal slider to the required 
position, noting that gain adjusts in 2 dB 
increments.  The gain value box (centered 
under the slider) displays selected gain. 

2. Click Apply or OK. 

PA Control Tab 
The PA Control tab provides a switch to turn PA 
Power ON or OFF.   

1. Click on ON or OFF in the PA Power box to 
change the value,  

2. Click Apply or OK for the setting to take effect. 

ACU Properties  
Select Alarm Control Unit from the Main Control 
screen Configuration menu to open the ACU Properties screen.  The ACU Properties screen 
includes tabs for I/O Descriptions, I/O Controls, Alarms, and DC Voltage Alarm Threshold. 

 

The ACU subsystem provides alarm and control functions for the repeater.  The ACU monitors all the 
repeater subsystems and reports status to a connection device or to remote devices through a dial-up 
modem connection.  In addition to monitoring the repeater system, the ACU contains a number of 
external inputs and outputs to monitor and control external devices. 

Inputs and Outputs 
RepeaterNet lets you monitor two digital alarm inputs and one DC voltage input from external devices.  
You also can activate up to four external devices with two relay outputs and two digital outputs.   

NOTE: Alarm settings for digital input 1 and digital input 2 are initially set to Disabled. 

The inputs and outputs are as follows: 

Relay Outputs 1 and 2 
The two relay outputs are configured with three leads in a Form C Contact Closure, with normally 
closed and common connectors closed with the switch in the OFF position and normally open and 
common connectors closed with the switch in the ON position. 

Digital Outputs 1 and 2 
The two digital outputs each have two leads that provide an opto-isolated circuit that presents a 
low impedance connection when the switch is in the ON position and a high impedance 
connection when the switch is in the OFF position. 
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Digital Inputs 1 and 2 

The two digital inputs each have leads that 
generate an alarm condition if the leads form a 
low impedance circuit (a closed contact), and a 
clear condition if the leads form a high 
impedance circuit (an open circuit). 

 

For information about connecting inputs and 
outputs to the repeater, see the PES800 NR 
Operations Manual. 

ACU I/O Descriptions Tab 
Label external equipment connected to the 
repeater’s inputs and outputs using the I/O 
Descriptions tab.  

External equipment could be a security light or any 
other site equipment. 

 

To add I/O descriptions: 

1. Select Configuration -> Alarm Control Unit to 
open the ACU Properties screen.  The I/O 
Description tab is active. 

2. Provide I/O descriptions in data fields. 

3. Click Apply or OK. 

ACU I/O Controls Tab 
The I/O Controls tab contains switches to turn Relay 
Outputs and Digital Outputs ON or OFF.  See Inputs 
and Outputs on page 10. 

ACU Alarms Setting Tab 

 

Redefine alarm severity for ACU subsystems on 
the Alarms Setting tab.  Subsystem alarms are: 

External Input Alarm (2 fields) 
An alarm generated from optional, external 
equipment. 

Fan Alarm 
A fan failure.  Replacement of the blower 
assembly is necessary.  See the Operations 
Manual. 

Temperature Alarm 
The system temperature threshold has been 
exceeded. 
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Tamper Alarm 

The repeater door is open. 

Analog Input Alarm 
The upper or lower limits for the monitoring of the external DC voltage source have been  
exceeded. 

External DC Voltage Alarm Threshold 
RepeaterNet can monitor an external DC voltage power source (a battery) in a range of 0 to 
60 volts in 250 mV increments.  In addition to monitoring the voltage level, you can define upper 
and lower limits for the voltage that is to activate the DC Voltage alarm in the ACU subsystem. 

To define an operating range for DC voltage: 

1. Select Alarm Control Unit from the 
Configuration menu to open the ACU 
Properties screen. 

2. Click the DC Voltage Alarm Threshold 
tab. 

3. Define (type in or arrow-click) the normal 
operating range for the DC power source 
in the Less Than and Greater Than 
data fields. 

4. Click Apply or OK. 

Modem Properties Screen 
From the Main Control screen Configuration 
menu, select Modem to open the Modem Properties screen.  This screen has three tabs: 

 

Alarms Setting 
Lets you set the alarm severity for the Modem alarm.  This alarm indicates a failure of the 
internal modem. 

Modem Properties 
Lets you define the port settings for the  
modem. 

Pager Setting 
Lets you configure a pager to be notified  
when a certain severity level alarm occurs. 

 Alarms Setting 
Use the Alarms Setting tab to redefine alarm  
severity for the repeater’s modem. 

1. Click the down-arrow next to an Alarm field  
to select a new alarm severity. 

 
2. Click on Apply or OK. 

Possible values are Disabled, Event, Minor,  
Major, and Critical. 

This alarm indicates a failure of the internal modem.  
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Modem Properties 

Define modem settings for the repeater’s modem using the Modem Properties tab. 

To define modem settings: 

1. Select Modem from the Main Control screen Configuration menu to open the Modem 
Properties screen. 

2. Click the Modem Settings tab. 

3. Define the Setup String, Phone 
Number, and Call Attempts. 

4. Click Apply or OK. 

Setup String is reserved for 
configuring a cell phone or modem.  
The cellular phone setup string is 
S37=6. 

Phone Number is the phone number 
of a remote computer to be called.  
This value is 0 unless you are using 
RepeaterNet Network Management 
software or other network management 
software.   

Call Attempts is the number of callout 
attempts before disconnecting; a zero (0) disables calling. 

 

Baud Rate is the communication speed between the modem and cell phone (which must be 
greater than 2400).  Baud Rate is adjusted automatically downwards by the modem when 
necessary. 

Set Parity to None.  Parity must be set the same as the computer’s modem. 

Set Data Bits to 8.  Data Bits must be set the same as the computer’s modem.  

Set Dial Type to Tone. 

Over-the-Air Repeater Modem Setup 
If an external wireless interface (such as the Telular) is connected to an Over-the-Air repeater, you 
must properly configure the repeater’s modem.  If the modem is not properly set up, few if any of 
the calls to the repeater will be successful. 

To properly set up your modem for all Peninsula Engineering Solutions repeater products 
(including the PES800, PES850, and PES1900): 

1. Connect to the repeater through the local Craft port. 

2. Launch RepeaterNet. 

3. Once the connection to the repeater has been established, select Configuration from menu 
bar at the top of the screen. 

4. From the Configuration menu, select Modem Properties. 

5. Click on the Modem Setting tab. 

6. Enter S37=6 in the Modem Init String field (the top field on the Modem tab). 
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7. Enter a Phone Number; for example 9, (222) 123-4567.  Each comma creates a 2-second 

delay in dialing.  Parentheses ( ) and spaces are ignored. 

8. Enter the number of times you want RepeaterNet to attempt to make the connection; for 
example, 3; 0 (zero) in this field disables calling. 

9. Click on Apply or OK at the bottom of the window. 

This procedure forces the repeater to initialize the modem to 2400 baud, which improves the 
connection on analog wireless networks. 

Changes made to the default settings on the Modem Properties screen take effect upon exiting 
RepeaterNet. 

Notes: 

⇒ If you configure a repeater to automatically call out and report alarm status, the repeater COM 
port settings must match the settings of the modem to be called. 

⇒ For users to log in to the repeater with a modem, the port settings of their computer’s modem 
(defined in the configuration file) must match the settings of the repeater modem.   

⇒ If the repeater is equipped with an internal modem, the setup string is controlled automatically 
by the repeater’s hardware.  If the repeater is connected to an external modem, consult the 
modem’s documentation for the setup string. 

⇒ Changes you make to the default settings on the Modem Properties screen take effect upon 
exiting RepeaterNet. 

Pager Setting 
You can set RepeaterNet to send out a page when 
a certain severity level alarm occurs. Use the Pager 
Setting tab to configure. 

A page is generated if the summary alarm severity 
is greater than or equal to the Minimum Severity 
you select.  When a page request is detected, the 
repeater terminates any current modem connection 
and generates a page.  The page format consists of 
the repeater number followed by the severity level; 
for example, 123456-2. 

If a change in the current alarm severity is detected, 
note the following: 

⇒ If the Minimum Severity is set to Major and a Major alarm comes in, a page with a 
severity of 2 is generated. 

⇒ If a Critical alarm is detected, page is generated again with a severity of 3 (Critical plus 
Major). 

⇒ If the Major alarm is cleared but the Critical alarm remains, a page is generated with a 
severity of 1 (Critical). 

⇒ If the Critical alarm is cleared, a page is generated with a severity of 0. 

⇒ If a Minor alarm is detected, no page is generated because the Minimum Severity is set 
to Major. 

⇒ Events do not generate a page. 
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Severity numbers are: 

No Alarms  0  Minor      4 
Critical  1  Critical + Minor    5 
Major  2  Major + Minor    6 
Critical + Major  3  Critical + Major + Minor  7 

To set a pager: 

1. Click on the Pager Setting tab of the Modem Properties screen. 

2. Enter the Pager Number, the number of times RepeaterNet should attempt to call the pager 
number (Call Attempts), and the number of the repeater (Repeater Number).   

The Pager Number is the phone number to be called.  This reflects the pager phone number, 
including networking access number (9), 1, and area code (if needed).  Access the network 
dial number and wait 5 seconds before sending the page sequence.   

Several commas must follow the phone number—each comma generates a delay of 1 
second.  Generally, it takes about 3 seconds for the pager company to pick up the line, and a 
maximum of 5 seconds before they drop the connection.  A good delay would be 5 seconds, 
in which case you would add 5 commas; for example, 9 1 (408) 555-1212,,,,, .  Spaces, 
dashes, and parentheses are ignored. 

3. Enter the Call Attempts, which are the number of retry calls to be attempted. A value of 0 in 
this field disables paging. 

4. Enter the Repeater Number (a system identification number or description). 

5. Select the minimum alarm severity for paging.  Values can be Critical, Major, or Minor. 

6. Click on Apply to set the values without exiting the properties screen; click on OK to set the 
values and exit. 

Cell Phone Properties  
From the Main Control screen Configuration 
menu, select Cellular Phone to open the Cell 
Phone Properties screen.    

The Alarms tab lets you set the alarm 
severity for the Cellular Alarm. This alarm 
indicates a failure of a cellular phone. 

To change alarm severity: 

1. Click the down-arrow next to an Alarm 
field to select a new alarm severity. 

2. Click Apply or OK. 

Severity levels include Disabled, Event, 
Minor, Major, and Critical. 

NOTE:  This severity should be minor.  The Cell Phone alarm is generated when the cell phone 
fails to report an alarm after all retry attempts by either the modem or the pager.  This 
alarm clears when the cell phone succeeds in reporting an alarm. 

When there is no cell phone, the Cell Properties selection is disabled. 
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Power System Properties  
From the Main Control screen Configuration menu, select Power System to open the Power  
System Properties screen.   This screen lets you access initial configuration settings for the  
power subsystem.   

Redefine alarm severity by: 

1. Clicking the down-arrow next to an 
Alarm field to select a new alarm 
severity. 

2. Clicking on Apply or OK. 

Power subsystem alarms are:   

Input Power Alarm 
The input power to the repeater is out 
of system tolerances. 

Power Supply Alarm 
The internal system power of the 
repeater is out of tolerances. 

Battery Alarm 
The voltage of the internal battery is below tolerances.  This battery supplies power to the 
ACU, modem, and cell phone in the event of a system power failure, letting the repeater call 
out and report its status.  It also supplies power to the memory that stores the Alarm and 
Event Log. 

NOTE:  The internal battery does not provide power for RF components and the repeater will not 
be able to provide RF coverage during a power failure. 
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End of Chapter… 
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Chapter 4.  Monitoring PES800 NR Status 

Monitor and control repeater system functions on subsystem Status screens. Click a subsystem 
icon to open its Status screen.   

Each Status screen includes one or more of the following tabs: 

Alarms 
 Reports present subsystem alarm states, with date and time stamps. 

Measurements 
Reports power and operational temperature measurements, including Low and High values.   
A Reset Low/High button resets values. 

Voltages 
Reports present voltages for a subsystem. 

Control 
Includes ON/OFF switches for internal and external subsystem hardware. 

Status screens for the PES800 NR are: 

� Channel Status 
� PA Status 
� ACU Status 
� Modem Status 
� Cell Phone Status 
� Power System Status 

Channel Filter Status  
Click a Channel 1 or Channel 2 Forward 
Filter icon (sine waves) to open a filter 
status screen.  This screen displays the 
alarm condition of the filter alarms.  The 
Alarms tab displays the most recent alarm 
state with severity, date, and time for a 
single channel select filter alarm.  A failure 
in the Forward or Reverse Filter assembly 
triggers an alarm and the filter becomes 
inoperative. 

PA Status  
Click an FPA   or RPA  icon to open a Forward or Reverse PA Status screen, which allows 
access to monitoring and operating tasks for the Power Amplifiers.   

The PA Status screens include tabs for Alarm and Measurement. 
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PA Alarm 

 

The Alarm tab reports subsystem alarms with 
date and time stamps—a failure in the PA 
assembly triggers an alarm. 

PA Measurement 
The Measurement tab reports the output 
power of the repeater, including low and high 
output values.  To reset low and high output 
values, click Reset Low/High. 

ACU Status  
Click the ACU icon to display ACU status 
information.  There are two tabs—Alarm and 
Measurement. 

ACU Alarm 
The Alarm tab reports subsystem alarms with 
date and time stamps.  A failure in the ACU 
assembly triggers an alarm.  The ACU alarms 
include: 

External Input Alarms (1 and 2) 
An alarm generated from optional, 
external equipment. 

 

Fan Alarm 
A fan failure.  Replacement of the blower 
assembly is necessary—see the 
Operations Manual. 

Temperature Alarm 
The system temperature threshold has 
been exceeded. 

Tamper Alarm 
The repeater door is open. 

 

Analog Input Alarm  
The upper or lower limits for the external 
DC voltage source have been exceeded. 

ACU Measurement 
The Measurements tab reports current, low, 
and high system temperature and DC voltage 
source values.  Click on the Reset Low/High 
button to reset the low and high values. 

Craft for the PES800 NR  Chapter 4.  Monitoring PES800 NR Status – Page 19
  



 
Modem Status  

 

Click the Modem icon to open the Modem 
Status screen, which reports a Modem 
Alarm with a date and time stamp.  Internal 
modem component failure triggers an 
alarm. 

Cellular Phone Status 
Click the Cellular phone icon to open the 
Cell Phone Status screen, which reports a 
Cell Phone Alarm with a date and time 
stamp.  This alarm indicates a failure of the 
cellular phone. 

Power System Status  
Click the Power icon to open the Power 
System Status screen.  This screen allows 
access to monitoring and operating tasks for 
the repeater’s power subsystem. 

Alarm 
The Alarm tab displays the status of the 
following alarms, with severity, date, and time information for each:. 

 

Input Power Alarm 
Indicates the input power to the repeater is out of tolerances. 

Power Supply Alarm 
Indicates system power of the 
repeater is out of tolerances. 

Battery Alarm 
Indicates the voltage of the internal 
battery is out of tolerances.  This 
battery supplies power to the ACU, 
modem, and cell phone in the event 
of a system power failure, letting the 
repeater call out and report its status.  
It also supplies power to the memory 
that stores the Alarm and Event Log. 

Battery Charger Alarm 
Indicates that the internal battery charger is not charging the internal battery. 

 

NOTE:  The internal battery does not provide power for RF components and the repeater will not 
be able to provide RF coverage during a power failure. 
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Voltages 

 

The Voltages tab shows the current power 
values for Battery Volts, Channel 1 PA Volts, 
and Channel 2 PA Volts. 

NOTE:  The voltage shown refers only to 
trickle charge voltage.  If the internal 
backup has been activated, the 
voltage shows as 7.5.
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Chapter 5. RepeaterNet Commands 

Commands available from the PES800 NR Main Control screen’s menu bar are described in this 
chapter. 

File Menu—PES800 Craft  
Open the Main Control screen File menu to display these RepeaterNet commands: 

� Download Properties 

� Upload Properties 

� Update Firmware 

� Exit 

Download Properties 
You can download all settings previously uploaded to a repeater with the Download Properties 
command.  You can use Download Properties to: 

� Download the default configuration file distributed with your Craft software to avoid  
having to manually configure each setting. 

� If you have used the Upload Properties command to store repeater configuration settings.  

The following preset configuration files are distributed with RepeaterNet Craft installation software 
and can be found by following this path: 

 Program Files -> Repeater Technologies -> RepeaterNet Craft 2.7.1 -> Default Configuration Files 

Configuration File Configuration 

OA800 2CH.rcf PES800 2-Channel repeater 

OA800 1CH.rcf PES800 1-Channel repeater 

 

To download settings to a repeater 
using the standard repeater 
configuration file: 

1. From the Craft Main Control File 
menu, select Download 
Properties; a confirmation box is 
displayed to give you an opportunity 
to change your mind about the 
download operation.   

2. Click on OK to proceed; a Select 
file to restore box is displayed. 

3. Select the repeater configuration 
file whose properties you want to 
download. 

4. Click on Open to proceed with the download. 
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This message box is displayed when the download is 
complete. 

Upload Properties 
System settings are stored in a repeater configuration (.rcf) file, which you can use to download all 
settings from one repeater to additional repeaters in a network, or to configure a replacement unit. 

Once you have configured a repeater, you 
can upload the configuration from that 
repeater to your workstation with the 
Upload Properties command.  You then 
can use the Download Properties 
command to copy the configuration to 
individual repeaters in your network. 

 

To upload system settings and create a 
repeater configuration file: 

1. Select a repeater and open Craft. 

2. Select File->Upload Properties to 
open the Select a file to save 
repeater properties to dialog box. 

3. Enter a name for the file without a file  
extension.  An .rcf extension is added  
automatically to the file name; for example, filename.rcf. 

4. Click Save to initiate the upload. 
 
When the upload is complete, this message box is displayed. 

5. Click OK. 

Save a copy of the repeater configuration file on a floppy disk 
for safekeeping. 

NOTES:  

� When you create a backup file, be aware that Repeater Configuration (.rcf) files created 
using a Network Monitor login include IDs and passwords.  

� The Repeater Configuration (.rcf) file is saved in the RepeaterNet program directory. 

Update Repeater Firmware 
Install a firmware upgrade with the Update Repeater Firmware command. Note that firmware 
updates are sent automatically to the designated point of contact for every affected owner of the 
repeater. Update packages are sent using overnight delivery and include a detailed notice, a 
floppy disk, and installation instructions.  

Direct any questions concerning the to the Peninsula Engineering Solutions Customer Service 
Department. 

To install a firmware upgrade: 

1. Read documentation provided with the firmware upgrade. 

2. Login to a session with the repeater to be upgraded. 

3. Insert the upgrade disk into the computer’s floppy drive. 
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4. From the Main Control screen menu 

bar, select File->Update Repeater 
Firmware.  This message box is 
displayed.  Click on OK. 

 
A screen is displayed that lets you save the 
repeater’s configuration.  You can choose to 
select a file into which the configuration 
should be saved, or click on Cancel to 
proceed with the firmware update.  

-- To save the configuration and continue 
with the firmware update, select an .rcf 
file and click Save. 

-- If you do not want to save the repeater 
configuration, click on Cancel. 

-- Clicking Save or Cancel causes the 
upload operation to proceed; an 
Uploading Repeater window displays 
the progress of the upload. 

 

5. When the upload is complete, the 
Select a firmware file to download to the repeater box is displayed.  In the Look In box, 
select the drive in which the upload disk is located. 

 

6. Double-click the upgrade file. It is labeled with an .s09 extension—for example, filename.s09. 
The previous firmware version is overwritten. 

7. When the upgrade is complete, the repeater’s configuration is restored automatically from the 
file you chose in the Open dialog. 

 

 

 

 

 

 

 

Exit 

 

 

The Exit command ends an active session with RepeaterNet and returns to the Welcome screen. 
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Configuration Menu—PES800C NR Craft  

 
Initial configuration of the repeater is done from the Configuration menu commands.   See 
Chapter 3. Configuring PES800C NR Properties on page 7 for detailed information. 

System Menu—PES800C NR Craft   
Open the System menu to display the commands described in this section. 

 

Properties 
Select Properties from the System menu to open the System Properties screen. 

NOTE:  When the repeater is on a network, the system name must be entered to match that at the 
Network Management Station in order for unsolicited alarms to be recognized. 

System Tab 
The System tab includes data fields for storing 
site-specific information—the system name (name 
of the repeater), brief site information (such as a 
network name or city location), and the repeater 
phone number for a repeater with a modem 
option. 

Entering summary data on the System Tab, 
although optional, is recommended. As a 
minimum, type a name for the repeater in the 
System Name field: during automatic reporting, 
the repeater name is displayed in the title bar of 
the Main Control screen, identifying the selected 
repeater. 

To record system data: 

1. Type required information in the data fields. 
2. Click Apply or OK. 
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System Inventory Tab 
The System Inventory tab includes data fields that 
provide information about the repeater to which you 
are connected. RepeaterNet reads this information 
directly from the repeater upon successful login.   

These information-only fields are described as 
follows: 

Assembly Part Number 
The part number of the repeater  
(for example, 090-1200-09). 

Serial Number 
The 9-digit serial number of the repeater. 

Date Code 
The date the repeater was built. 

Hardware Revision 
The repeater hardware revision (such as Rev. A). 

Boot Code Version 
The version of the boot code installed in the repeater. 

Installed Options 
Optional internal equipment in the repeater (such as a cell phone). 

Firmware Version 
The firmware version installed in the repeater. 

System Login Tab 
The System Login tab includes fields to type in 
login IDs and passwords and to configure the 
Auto-Logout function.  

In the Auto-Logout Inactivity Time field, define 
how long RepeaterNet should wait, during a period 
of inactivity, before terminating a session.  A time 
interval in minutes between 1 and 60 can be defined 
independently for each access level.  If you enter a 
zero in a time field, this feature is disabled. 

NOTE:  When the repeater is part of a network, the time 
field must be zero (0). 

To change a login ID or password: 

1. Login to the repeater (as an administrator). 
2. Select Properties… from the System menu. 
3. Click the Login tab. 
4. Type the new login ID or password (using six or fewer characters) into the appropriate fields. 
5. Write down login IDs and passwords and secure in a safe place. 
6. Click Apply or OK to set the new information. 
7. Notify affected operators of ID and password changes. 

NOTE:  When the repeater is networked, this information also must reside in the NMS Database. 
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Alarm and Event Log 

Open the Alarm and Event Log from the System menu to view the alarm and event history of the 
OA1900 NR.  The log is dynamically updated during viewing. 

Line entries in the Alarm and Event Log are organized as follows: 

1. Subsystem affected by an alarm or event 
2. Alarm severity 
3. Date and time stamp 

Saving, Printing, and Editing the Log 
Alarm and Event Log entries can be printed, saved, or edited using Notepad.  Click on Run 
Notepad; a copy of the Alarm and Event Log is displayed in a Notepad window, in which you can 
edit the log. To print or save the log, select Print or Save as… from the Notepad File menu. 

Options Menu—PES800C NR Craft  
Open the Options menu to display these RepeaterNet commands. 

 

Color Independent Icons 
Color Independent Icons are special graphic indicators designed to assist operators unable to 
distinguish colors. As part of the alarm reporting system, Color Independent Icons display on the 
Main Control screen for a Critical, Major, or Minor alarm. By default, the Color-Independent Icons 
feature is OFF.  

From the Main Control screen menu bar, select Options->Color Independent Icons to turn ON 
this feature. 

Alarm Type Color Independent Icon 

Critical X through the subsystem icon 

Major Back slash (\) through the subsystem icon 

Minor Dotted-line back slash through subsystem icon 

Alarm Sounds 
The Alarm Sounds feature allows an intermittent alarm to activate when a subsystem triggers an 
alarm. By default, the Alarm Sounds feature is OFF.  

From the Main Control screen menu bar, select Alarm Sounds from the Options menu to turn 
ON this feature.  

NOTE:  During an alarm, either clicking a subsystem icon to open the Status screen or clearing the 
alarm silences an audible alarm. 

Hold Connection 
The Hold Connection feature maintains the direct or dial-in connection to the repeater for 
monitoring until you terminate the connection. 
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Help Menu—PES800C NR Craft  
RepeaterNet on-line help is designed to provide quick access to information related to the 
operation of the repeater.  

� To open RepeaterNet Help, select Help->Help Topics. 

� To learn about the version of  RepeaterNet Craft, RepeaterNet NMS, or RepeaterNet 
Administrator installed, select About…  from the Help menu of any program window.   

Navigating Help 
� From the Contents tab, double-click a book icon to open its contents, then double-click a topic 

icon to open its Help page. A help page provides detailed topic information. Help pages can 
contain links—identified by green, underlined text—to related topics. 

� From the Index tab, type a topic name in the data field to automatically jump to a topic or use the 
scroll bar to locate a topic entry. Double-click an index entry to open its Help page. 

� Click the Index tab to open the Find Setup Wizard utility, which searches for specific words and 
phrases instead of searching by category. Follow the prompts. 

� To find out the version of RepeaterNet in use, select About from the Main Control screen Help 
menu. 

Exiting RepeaterNet 
To exit RepeaterNet, return to the Main Control screen File menu and select Exit.  
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Appendix A.  Default Alarm Settings 

NOTE: Default values for gain are set to the minimum value—55 for Forward PA Gain and 50 for 
Reverse PA Gain. 

 
Subsystem 

 
Alarm 

Default 
Severity 

 
Subsystem Problem 

 
Effect on Service 

Filters: Channel 1 Forward Filter Event Loss of phase lock.* Interrupted  

and Channel 2 Reverse Filter Event Loss of phase lock.* Interrupted  

PAs: Forward Power Amplifier  Critical PA power supply current 
out of range.* 

Interrupted (turn OFF PA) 

and Reverse Thermal 
Shutdown  

Critical PA temperature too high.* Interrupted (turn OFF PA) 

 External 
Shutdown  

Critical Local Wireless Technician 
has manually shut-down 
Power Amps.* 

Interrupted (turn OFF PA) 

 FE (Front End) 
Attenuation 
Active (reverse 
only) 

Major  Fast acting/fast release 
Hot-Tone front-end 
protection activated.  
Protects RFE from mobile 
parking under subscriber 
antenna. 

Degraded service.  
Repeater coverage area 
reduced until offending 
signal goes away. 

ACU External Input 1 Disabled† External Input 1 Alarm 
initially is disabled. 

None 

 External Input 2 Disabled† External Input 2 Alarm 
initially is disabled. 

None 

 Fan Major Fan stopped working.* None, but eventual thermal 
shutdown probable. 

 Temperature 
(system temp.) 

Minor Repeater heat sink temp 
too high.* 

None, but eventual thermal 
shutdown possible. 

 Tamper Alarm 
(door open)  

Major Someone has opened the 
repeater cabinet door. 

None, but possible security 
breech. 

 DC Voltage Disabled†  n/a 

Modem Modem Minor Modem not working.* None, but reporting 
disabled and remote 
connection impossible 

Cellular Phone Cellular Phone Minor Cellular phone not 
working.* 

None, but reporting 
disabled and remote 
connection impossible 

Power Supply Input Power Critical Loss of AC or DC input 
power to repeater.* 

Interrupted 

 Battery Minor External battery voltage too 
high or too low.* 

None, but repeater cannot 
call out in event of system 
power loss. 

 Power System 
(internal) 

Major Loss of one or more 
internal power supply 
voltages.* 

Interrupted 

†If external inputs or equipment are used, set alarm severity as appropriate. 
*May require maintenance visit to the repeater. 
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Appendix B.  RepeaterNet Executables 

The installation program installs all necessary application executables and associated support 
drivers in a Windows folder you select or, by default, in c:\Program Files\RepeaterNet\Craft.  
The installation program also provides entries into the system registry.   

The main RepeaterNet executable files are: 

CraftAdmin The Database Administrator program, used to configure and select the 
communications port used by RepeaterNet Craft. 

RepeaterNet The Craft graphical user interface for different repeater hardware types.  
Used in the setting and viewing of individual repeater items. 

When any of these executable files are running, an icon is displayed on the Windows Task Bar. 
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Appendix C.  The OKI Cellular Phone 

Accessing the OKI Cellular Phone 
The cellular phone is located on the inside door of the PES800 NR.   
Open the repeater door and unscrew the four screws securing the metal box lid. 

   
 

To remove the cellular phone for programming, disconnect plug at base of phone. 

NOTE:  The AC charger and cell phone antenna are provided in the accessory kit.  

Programming the OKI Cellular Phone 
An abbreviated set of instructions for NAM programming of your Oki Phone is provided  
in this section.  For more detailed information, see your OKI PHONES 1400 Series  
documentation. 

Programming Mode Access 
1. Turn the power on and press Rcl + Func keys at the same time. 

2. Enter your 5-digit special password within 30 seconds. 

3. After the special password is logged in successfully, ESN/HEZ Number  
and Software Version Number are displayed for two seconds each. 

4. Two seconds later the Speed Dial Memory reset prompt is displayed. 

5. Proceed to the next section, “Speed Dial Memory Clear,” or press  
volume ▲▼ to scroll within the NAM Programming menu.  
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Speed Dial Memory Clear 
Scroll the NAM Programming Menu until “Spd dial” appears n the display,  
followed by the reset prompt (“reset-0”).  Press 0 to clear the Speed Dialing Memory. 

Default Data Set 
Scroll the NAM programming menu until “def data” appears on the display, followed  
by the reset prompt ("“reset-0").  Press 0 to reset all user programmable functions to 
the Manufacturer’s default. 

Lock/Unlock Code Programming 
1. Scroll the NAM Programming Menu until “Uloc and (current code)” appears on  

the display.  The default is “1234.” 

2. Enter a new 1-to-4 digit unlock code and press Sto key. 

Telephone Number Programming 
1. In this menu, you can program information that is unique to Telephone #1.   

Follow the instructions or press Clr to skip to Telephone #2 or the next item  
on the main NAM Programming menu. 

2. The display indicates “tel.no 1” followed by the last seven digits of the  
current phone number.  Enter the new number (area code plus telephone  
number) and press Sto. 

Authentication Key Programming 
The display indicates “Auth.no.” followed by “Entr.no.”  Enter the authentication  
key provided by the carrier (up to 26 digits) and press Sto.  If an invalid number  
is entered, the display shows “not good” followed by “Entr.no.” 

Home SID Programming 
Enter a 5-digit SID number and press Sto.  The IPCH Number Initial paging  
channel number is set automatically depending on the stored Home SID number. 

ACCOLC Number 
The current number is displayed.  Enter a new number if required, then press Sto. 

GID Number 
1. The current number is displayed.  Enter a new number if required, then press Sto. 

2. Press Clr to return to the main NAM Programming menu. 

Emergency Number 
1. The display shows “Help no.” and the current setting.  Enter a new number  

(up to 11 digits) if required. 

2. Press Sto. 
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Preferred SID Programming 
1. Scroll the Preferred NAM Programming menu.  Press Rcl and enter the  

desired Preferred SID number (5 digits). 

2. Press Sto.  You can enter up to 50 SID locations. 

3. Press Clr key to advance to the next programming option. 

Language Option Set 
Press Rcl and scroll through the available options.   

When the desired language is displayed, press Sto. 

System Options Programming 
1. Scroll the NAM Programming menu and press Rcl to enter the Option  

Programming menu. 

2. While in this menu, press Rcl to change settings and Sto to save and  
go on to the next setting.  Press Clr at any time to return to the main  
NAM Programming menu. 

Option bits are defined as follows:      0   0    0  1   1    0   1   0 

 0 = Reserved for future use  
 0 = Reserved for future use 
 0 = Reserved for future use 
 1 = MINMK = Mobile ID Number Mark (0=No, 1=Yes) 
 1 = LUMK = Local Use Mark (0=No, 1=Yes) 
 0 = AMMK = Audio Mute Mark (0=Call, 1=Always) 
 1 = HFMK = Handsfree Mark (0=No, 1=Yes) 
 0 = HAMK = Horn Alert Mark (0=No, 1=Yes)   
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Appendix D.  Troubleshooting 

The following attempts to identify the most common problems associated with the successful 
operation of the RepeaterNet system.  The steps listed to resolve the problem may not include all 
of the possible reasons for non-operability, but may assist in identifying the actual difficulty.  The 
problem attributes in the following paragraphs have been ordered with the most likely problem 
listed first. 

If you continue to have problems, call Peninsula Engineering Solutions Customer Support for 
assistance.  See inside the front cover of this document for current telephone numbers. 

Problem 1: The RepeaterNet Server reports that it cannot open the NMS database. 

Either the DSN is configured improperly, does not point to the proper location, or the system did 
not find the DSN itself. Call Customer Support for assistance. 

� The correct DSN or User ID is not identified. 
� The Windows ODBC drivers are not installed. 
� The database file pointed to by the DSN is corrupted or needs repair. 

Problem 2: The Process Manager component of the RepeaterNet Server reports that it 
cannot read the database Ports table. 

No ports have been configured in the system database.  The Ports table in the database may be 
corrupted.  Repair the database and retry. 

Problem 3: The System starts up without error but, when a repeater graphical user 
interface is launched, no detailed data is displayed.. 

Wait for up to 4 minutes (cell modem connection) to see whether the program can connect to the 
repeater.  If not, a warning message will pop-up indicating communications could not be 
established. 

Problem 4: A specific port does not seem to be in use and an Alert exists, or the 
database log reports the error “Unable to initialized port COMn” where n is 
the designation of the non-functioning port. 

The port number has been configured incorrectly or the port does not exist. 

The port is assigned to another program operating in the same PC.  Windows does not permit the 
sharing of communications ports between active programs.  Shut down the other program. 

Problem 5: The system reports “Unable to connect to repeater...”   

This can be an indication of: 

� The cellular carrier is not handling the call 
� The phone number provided is incorrect or out of service 
� A problem with the modem or phone line 
� A problem with the repeater 

Problem 6: The system reports the message “An unsupported operation was 
attempted.” 

This message appears when the installation failed to register the OLE controls for alarm bitmaps. 
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Problem 7:   RepeaterNet conflicts with Microsoft Fax. 

To disable the auto answer mode: 

1. Open the mail icon from the Control Panel. 

2. Select Microsoft Fax from the Services tab. 

3. Click on the Properties button. 

4. Select either Manual or Don’t answer radio button. 

5. Click OK to save. 

Problem 8:   NMS Client reports “Cannot find application RepeaterNet Server.” 

This can occur when the Server is not running or a network failure prevents the NMS Client from 
connecting to the Server.  Verify that the Server is running and that the Server’s host is 
accessible. 

Another possibility is a conflict with the port assigned to the Server.  This problem has been 
known to occur with a port number that previously had no conflict.  Run the program 
“RepNetConfig.exe” in the RepeaterNet directory and increase the value of “Server Port” by one.  
Restart the Server and NMS Client. 
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